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1 Introduction

11  Integration of NAV CRM with Lotus Notes

With the CRM module for Dynamics NAV, close integration between a company’'s business
management functions and the sales process can be achieved.

In connection with the management of activities in the CRM system it is essential that appointments
and To-dos can be synchronized with the user’s calendar. Likewise, it is important for the user to be
able to use his e-mail system for sending e-mails from the CRM system.

The standard version of NAV CRM supports only Microsoft Outlook as e-mail and calendar client.
With INTOGRATE NAV — CRM for Lotus Notes, it is possible to use the e-mail, calendar and contact
person facilities of Lotus Notes.

To avoid unnecessary changes in the NAV application, the term Outlook is sometimes used in stead
of Lotus Notes, e.g. in the error log which provides information about errors occurring in connection
with the integration.

For further help with the CRM part in NAV, see the user documentation for Dynamics NAV.

This manual is based on Dynamics NAV 2013/2015/2016. This means that screen dumps and the
menu items, etc. were taken from this version.

12 Target group

This manual can be used by system administrators, developers as well as NAV users.

NAV developers can find additional information in the manual for INTOGRATION NAYV - Developer,
and in Appendix A where adjustments to the standard NAV CRM module are described.

13 Terminology

In the following sections, elements of NAV, references to menus, etc. are referred to as described in
the below table:

<KEY> Refers to a key on the keyboard. For example, <ENTER>
means that you must press the Enter key.

‘Menu\sub-menu\menu item’ Refers to a menu selection. For example, 'File\Open’
means that you must click ‘Open’in the 'File’ menu.

“c:\Lotus\Notes” Refers to a path to either a file or a directory. Notice that the
style resembles that of a menu selection.

NAVElement NAV elements are referred to in italics, e.g. the code unit
Mail.

[button] Refers to a button on the screen. For example, [OK] refers
to a button with the text ‘OK’.
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14  Components

The Integration Kit is divided into four main components:

e The Integration Kit. This component handles the underlying communication between Lotus
Notes and NAV.

e COM component which handles the overall communication between NAV and the
Integration Kit.

e Mail component. This is used for sending e-mails.

e CRM component which handles the business logic in connection with the CRM part of NAV.

147 Integration Kit
The Integration Kit mainly consists of the files: erp2In.dll, ERP2LN_addon.dll and ERP2LN_COM.dlI
ERP2LN.dIl handles all communication between NAV and Lotus Notes.

The Integration Kit can also be used for other types of integration. For example, it is also used for
integration between Lotus Notes and Dynamics AX.

142 COM component

The COM component enables use of the Integration Kit from NAV by means of COM technology.
This component is the link between the Integration Kit and the rest of NAV.

143 NAV Mail component

NAV uses this component to send e-mails. It replaces the part normally used for Microsoft Outlook.
This means that no major adjustments are required in order to switch from Outlook to Lotus Notes.

The component comes as a single code unit called Mail. It can be used individually and does not
require the CRM component to be installed.

144 NAV CRM component

The CRM part of NAV consists of several elements. It handles e.g. synchronization of to-dos,
appointments and contact people between Lotus Notes and NAV. It also includes extended e-malil
functionality which enables journaling of e-mails from Lotus Notes to both people and companies in
NAV.

It includes both new elements and adjustments to existing ones. Appendix A includes a detailed
description of the affected elements in NAV.
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2 Program installation

The Integration Kit should normally be installed from a workstation where Lotus Notes and NAV
clients are installed. All descriptions and tasks are based on the assumption that they are carried out
from a local workstation.

2.1 Before you start

211 System requirements
The following software is necessary:

e Microsoft Windows Workstation/Server, NT, 2000, XP, Vista, Windows 7, Windows 8.

e Lotus Notes client version 5.02c or newer

e Microsoft NAV Attain DK 3.60, Microsoft Business Solutions-NAV DK 3.70, Microsoft
Business Solutions-NAV DK 4.0, Microsoft Dynamics NAV 5.0, Microsoft Dynamics NAV
2009, 2013, 2015 or Microsoft Dynamics NAV 2016 (32 bit client).

22 Checklist

Before you begin the installation of the Integration Kit, it is recommended that you carry out the
following points. They may prevent potential problems not related to the Integration Kit itself.

e Start your local Lotus Notes client. Use the shortcut key <CTRL>+<M> to create a new
e-mail. If an error occurs at this point, this must be fixed before the installation of the
Integration Kit can continue. It is a prerequisite that the Lotus Notes e-mail client is set up
correctly and that it is possible to send e-mails from the client.

e Since NAV uses the local Lotus Notes client for e.g. sending e-mails, the user will be
prompted for a password for Lotus Notes when starting NAV regardless of whether the
Lotus Notes client has been started or not. This can be changed so that the entering of a
password is not necessary if the Lotus Notes client has already been started. Start your
Lotus Notes client and select the menu ‘File\Tools\User ID’. Mark 'Don’t prompt for a
password from other Notes-based programs..’. Close the dialog box by clicking [OK]. After
this, the user will not be prompted for a Lotus Notes password when starting NAV.
(However, this requires Lotus Notes to be running in the background and the user to be
logged in).

e Itis recommended that you disable visible notification in Lotus Notes. This can be done
from the menu ‘File\Preferences\User preferences..’. Select the ’'Mail and News’ icon on the
left side of the dialog box. Deselect 'Visible Notification’ in the 'Receiving’ section. This
change is advantageous because Lotus Notes is locked when a message indicating that
new mail has arrived is being displayed. The Integration Kit can thus not access Lotus
Notes as long as the message is shown.

e Start NAV and make sure that you have a valid user name and password for NAV. Do not
forget to close NAV before you continue with the installation.
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23 Installation of the Integration Nit

Insert the CD called “INTOGRATE NAV - CRM" If the installation program does not start
automatically, double-click "setup.exe” in the root of the CD (Click 'Run’ in the Windows Start menu
and type "D:\setup.exe” if the CD-ROM drive is the D-drive).

Follow the installation guidelines on the screen. For a detailed description of the installation, see the
section “Manual installation” in the whitepaper “Technical Guidance - INTOGRATE NAV.pdf’.

24 license file

To use INTOGRATE a license file must be installed.

This file can be obtained either by purchasing a license for INTOGRATE or by downloading a demo
version from our website (http://www.intograte.com).

The license file must be copied to the directory where the product was installed (the directory where
"erp2In.dll* is located).

29 Installation of NAV elements

The following instructions are based on the English language layer (United States). If NAV is set to
another language you can switch to English by selecting the menu item Language’in the ’Functions’
menu and select English(United States).

1. Start NAV Development Environment and select 'Object Designer' in the "Tools' menu
(short cut key: [SHIFT]+[F12])

2. Select 'Import' in the 'File' menu.

3. Find the directory where you installed INTOGRATE NAV and open the sub-directory
"NAV” (INTOGRATE is usually installed in "C:\Program Files\INTOGRATE NAV”).

4. Select the file INTOGRATE NAV - CRM - X.XX.fob” and click [Open].

X.XX is determined by your version of NAV:

3.60 Microsoft NAV Attain 3.60

3.70  Microsoft Business Solutions-NAV 3.70
4.00 Microsoft Business Solutions-NAV 4.0

5.00 Microsoft Dynamics NAV 5.0

5.10 Microsoft Dynamics NAV 5.0 Servicepack 1
6.00 Microsoft Dynamics NAV 2009

7.00 Microsoft Dynamics NAV 2013

8.00 Microsoft Dynamics NAV 2015

9.00 Microsoft Dynamics NAV 2016 (32 bit client)

5. If existing NAV has modifications, these must be handled before the importing can
continue.
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J. Setting up NAV and Lotus Notes

The following section describes how NAV must be set up so that the integration to Lotus Notes can
be run.

As each Dynamics NAV 2013/2015/2016 installation can have its own role-center setup, the location
of the individual components can differ from the examples below.

a.1 Setting up users

To enable a user to use the Lotus Notes integration, some information about the user’s Lotus Notes
settings must be entered.

To carry out this setup, select Departments/Sales and Marketing/Administration/Lotus Notes/
Configuration/User configuration’.

-

iy Edit - Lotus Notes user setup =R X
m Home | Actions CRONUS Danmark A/S (@
; 2 [E] View List A -
7 A %l i &) T
Mew Edit  View ) Show as Motes  Links
/% Delste Chart
Lotus Notes user setup ~ Typetofilter (F3) | Code a2 ©@
Serting:  Code = ‘El‘ Mo filters applied
Code <MAV UserID>  Enable... Mail server Mail database Contact server | Contact database
T~ INTOINTWFLM v local mail\Mavision2013.nsf  local Mavision 2013 NAB.nsf
0K

For each user who is to use the Lotus Notes integration, the following procedure must be followed:

1. Enter the NAV user code in the ‘Code’ column. This can be done by typing in the code or
selecting the user from the list of users.

2. Type in the NAV user ID’ name or select it from the list.

3. Select ‘Enable synchronization’. This activates the Lotus Notes integration for the user in
question.

4. Enter the name of the server where the user’s mail file is located in the ‘Mail server’ field.

5. The ‘Mail database’ field must contain the relative path to the mail database, e.g.
"mail\kin.nsf”. The path must be relative to the "Lotus\Notes\Data” directory in the mail
server specified.
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If contact synchronization is to be used, the following must be carried out:

6. Enter the name of the server where the user’s local address book is located in the
‘Contact server’ field (the address book can be the local address book in the Notes client

or a common address book on a server).
7. The 'Contact database’ field must contain the relative path to the address book. The path

must be relative to the "Lotus\Notes\Data” directory in the server specified.

3.2 General configuration

The general configuration defines the setup for all users integrating with Lotus Notes.
The setup is found through: Departments’ -> ‘Sales and Marketing’ -> 'Administration’ -> Lotus
Notes’-> ‘Configuration’ -> 'Configuration’.

-

iy Edit - Lotus MNotes Configuration AN X
m Home Actions CROMNUS Danmark 4/5 ':Ei'

{)-./ J ]

View Mates  Links

Lotus Motes Configuration

General -
Storage server: (] Storage database: demo'\Mavision 2013...
Autoematic synchonization at login:

MailMerge A
File format: Filtered HTML - Importtype for mailmerge: Import -
Open Dialog: Mame for attached files: REPORT

0K

b

321 Configuration of storage server for E-mail journaling

E-mail journaling enables the loading of e-mails sent and received from the user’s mail database in
Lotus Notes. The e-mails are then attached to a contact in NAV, and a copy of the e-mail is saved in
a central database on a Domino server (storage server).

The users who are to journalize and be able to open journalized e-mails must have reading and
writing rights to this central database.

Enter the server name in the ‘Storage server’ field and the database name in the ‘Storage database’
field.

The database must be based on a standard mail template.

Journaling uses full-text searching in the users’ mail databases and this must therefore be activated.
Follow the below procedure to check if indexing has been activated in a mail database:

1. Start the Lotus Notes client and open the mail database.
2. If the search field is not already visible, select the menu item ‘Search This View’in the

View’ menu.
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3. Ifthe word © Indexed gppears in the top right corner of the search dialog, the full-text
index is active and no further setting up is needed (you do not need to continue with this

procedure).
Mew - Reply - ReplytoAll - Forward~ [~ P - T - More- C Q- Show ~
Search in View "Inbox’ Show results |Sorted like current view j (2 Indexed ? x

Search for Search ﬂ

Sort by Date

4. If, instead, it says © Notindexed ' the fy||-text index must be activated. To do this click the

icon © Notindexed This will open the 'Create Full-Text Index’ dialog box.
5. Click the [OK] button to create the full-text index (the standard settings are usually
sufficient).

6. After a while, the index will be updated (the © MNotindexed joon will switch to © Indexed .
If you have received an e-mail and want it journalized in NAV, the full-text index may not have been

updated. In this case the e-mail will not appear in the journaling list in NAV until the index has been
updated (this normally takes place automatically).

See Lotus Notes Help to find out how to manually update the index.

322 General mail setup

Synchronization of contacts and appointments/meetings between NAV and Lotus Notes can be
performed both automatically when signing in to NAV or manually though the menu-system (see
section 5.3.2).

If synchronization should be performed automatically for the users when starting NAV, click the
checkbox ’Automatic synchronization at login’.

When merging mails from NAV through Lotus Notes, the documents can be either imported to the
body-segment of the mail or attached to the mail.

The field File format’ defines which format merge-documents are converted to before import or
attachment, and the field Importtpe for mailmerge’ defines if documents are to be imported or
attached.

Remark: The maximum size of a file to be imported to Lotus Notes via INTOGRATE, is 40.000
bytes. It is strongly recommended to use the file format: “Filtered HTML” (HTML with images
stripped of) when using the “import” method, as this format produces the smallest files.

When using the “Attach” option there is no size limitations.

Normally, when sending mails through the interaction system, the mails are sent without further
user-interaction in Lotus Notes.

If it is preferred to open the mails in Lotus Notes before they are sent check the option Open mail
dialog’in the configuration form.

The field 'Name for attached files’ sets the name of the merged document, when using the “attach”
method.
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4 Getting started

This section describes how to quickly start using the integration between Lotus Notes and NAV.

You are presupposed to have some knowledge of NAV and have a user set up to synchronize with
Lotus Notes.

For the next few sections, you are recommended to keep your Lotus Notes running in the
background.

41 Sending e-mails

The following example describes how to send one e-mail to a customer in the customers table.
Start by opening the customer card for a customer (select the menu item 'Sales & Marketing/Order
Processing/Customers’in the Departments’ menu and select ‘Edit’).

Open to the ‘Communication’ tab and enter an e-mail address in the ‘E-Mail’ field if it is not already
filled in.

To send an email, click the E=
mail in the send-to field.

icon. This will open the mail in Lotus Notes with the customers e-

42 Creating imteraction e-mail

Start by opening the contacts view (select the menu item ‘Sales & Marketing/Order Processing/
Contacts’in the Departments’ menu) and click the [Create interaction] button foracon 41

Create
Interact

e —
Edit - Create Interaction - EO00020 Meereen Meubelen KT 10012, (| o=l e
Actions Mavigate CRONUS Danmar... i@

L~ NE.’:‘:

+4 Refresh

This wizard helps you to create interactions and record informaticon
regarding their cost, duration and connection to a campaign.

Wheo are you interacting with?: |
What is the type of interaction™: -
Language Code:

Whao is the salesperson responsible®: IR -

Describe your interaction.:

11/20



This will open the Interaction wizard which can eventually result in merging a document that will be
sent through Lotus Notes.

The behaviour of this process, e.g. if the merged document are imported to the mail body or
attached, can be setup in the Lotus Notes configuration in NAV (see section 3.2.2).

43 Synchronisation of to-tos and appointments

The Integration Kit enables you to automatically synchronize your appointments and to-dos between
Lotus Notes and NAV. When you create new activities you must be aware that in NAV CRM, only
meetings and phone calls will be transferred to Lotus Notes.

Select a contact through 'Departments/Sales & Marketing/Order Processing/Contacts’
Select the tab Navigate’ and clic';, *~e [To-dos] button T, see to-do list.
Press the [Create To-do] button cT;_iEo create a new to-do item.

Edit - Create To-do - E000020 Meersen Meubelen KT100148 ... (s=lsE) ]

Actions CROMUS Danmar... 'Z'E':'

[ Mext

+4 Refresh

This wizard helps you to create to-dos.

What is the type of the to-do™: Meeting -
Describe your to-do.: MAY 2013 Appointrment

All Day Event:

What is the start date of the to-do®:  17-12-2013 -

What is the start time of the to-do?:  15:00:00
What is the duration of the to-do? 1 hour 30 minutes

What is the end date of the to-do¥: 17-12-2013 -

What is the end time of the to-do™: |

Team to-do:

Select 'Meeting’ in the 'What is the type of the to-do’ selection box (or ‘Phone call’ if you want to
make a Lotus Notes ‘To-do’ document). Enter the subject of the appointment in the 'Describe your
to-do’ field. The subject will appear in *Subject’ in the Lotus Notes appointment.

Enter a start time and an end time. If the appointment will last a whole day select 'All day event'.
Click [Next >] to invite participants to the appointment (these will not be transferred to Lotus Notes).

Click [Next >] and, if relevant, select the campaign to which the appointment relates and attach a
subject. If you enter something in the 'Location’ field, this will be transferred to the field with the same

12/20



name in Lotus Notes. Click [Next >] and then [Finish] to create the appointment in NAV and Lotus
Notes.

In Lotus Notes, the appointment will appear as any other appointments:

New - More -

Mandag den 16. december 2013

Tirsdag den 17. december 2013

15:00 - 16:30 NAV 2013 Appointment
Flemming Miglsen

If you further amend it in NAV, the changes will be updated to Lotus Notes. If you change the
appointment in Lotus Notes these changes will be updated too in NAV.
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44 Synchronising contacts

For exchange of contacts to be possible, an address book must be specified in the settings for the
user in question. See section 3.1 for help with setting this up.

At the first synchronization, all contacts attached to the user will be transferred to the address book.
To attach a contact, enter the initials of the user in the ‘Salesperson Code’field in the contact card.

Select a contact for which the ‘Salesperson Code’is set to the logged in user, in this case 'JR’:

_ iy Edit - Contact Card - KT100148 . Monica Brinks

E Home Actions Navigate Report

= View 3 0 Create Interact
=|New 77 Sales Quotes fula]
. Apply o Contact
7< Delete Template.. £ Statistics Cover Sheet
KT100148 - Monica Brinks
General
MNo.: KTl[I)l-IS Country/Region Code: ML
Type: Person - Search Mame: MONIC/
Company No.: E000020 - Phone No.: 123456
Company Marme: Meersen Meubelen Salesperson Code: JR
Marme: Muonica Brinks Salutation Code: K
Address: Viffpoortenweg 71 Last Date Maodified: 10-01-2C
Address 2: Date of Last Interaction:  23-01-2C
Post Code: ML-6827 BP - Last Date Attempted: 23-01-2C
Mext Te-do Date: 02-01-2C
City: Arnhermn - oreobate

Change e.g. the address and jump to the next contact by pressing <Ctrl>-<Page Down>. Switch to
Lotus Notes and open the address book (the one that was set up for integration in section 3.1).

The following will appear in Lotus Notes:

Few 55 Q f

Monica Brinks
Meersen Meubelen
monica.brink@cronuscorp.net

123456
E-mail Addresses
Business: monica.brink@cronuscorp.net Business: Vijffpoortenweg 71
Phone Numbers Armhem NL-6827 BP
Business: 123456 Nederlandene
Maobile: 654321
Other Information
Mes=saging ID: monica.brink@cronuscorp.net

Comments | Name Information | Certificates
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dJ. Using the integration

In this section the various fields of application will be described in detail.

a.1 E-mail

In NAV there are several ways to use the e-mail facilities. The following examples can be
mentioned:

e You can use the e-mail icon ( E= ) in NAV. This will start Lotus Notes, open a new e-mail
and fill in the 'To’ field.

e Automatic sending of notification when a service order has been marked complete. This
can be set up through job scheduling.

e In NAV 2013/2015/2016 it is not possible to use the “Print & Send” functionality with
Lotus Notes.

a11 Sending e-mails from contact card amd customer card

The Lotus Notes e-mail client can be activated from any location in NAV were the e-mail icon ( EH )
appears. The To’field is automatically filled in with the contents of the e-mail field in NAV. The other
fields must be filled in manually.

Examples of places from where e-mails can be sent through the e-mail icon are through the contact
card under the communication tab and on the sales person/purchaser card in the ‘General’ tab:

3.2 E-mail journaling

Journaling is used for loading e-mails sent and received from Lotus Notes and then attaching them
to contacts in NAV.

To set up journaling, follow the instruction in section 3.2. The user who is to perform the journaling
must be activated in the synchronization settings.

To start the journaling, go to Departments/Sales and Marketing//Lotus Notes Integration/ E-Mail
logging”. This will start the journaling.

Edit - I21 E-Mail Logging Filter L2 [l

{Retrieve e-mails after: |

After date: 13-12-2013 15:46:17.....

Only retrieve e-mails from today:
Filter on date interval:

From:

To:
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If the checkbox ‘Retrieve e-mails after’ is checked, only mails received or sent at the date on or after
the date specified in ‘After date’ is fetched (suggests a date 30 days before today). Further date-
refinement can be entered though the ‘Filter on date interval’ selections.

Mails from today can also be selected.

Only mails that has not been processed before is loaded to NAV, so if no date selections is entered,
all mails that hasn'’t been processed before will be shown.

-

i Edit - [21 E-Mail Journaling | |

r O

Delete Post

Line No. Date Time From To Subject Contact No.  Ignore
1 12-01-2014 17:55:29 CM=Flemming Nielsen/O=Intoint fin3400@grnail.com Test multiple receivers E000001 |l
2/12-01-2014 | 17:55:29 CN=Flemming Nielsen/O=Intoint IntointMailUser@Into... Test multiple receivers =
1 09-01-2013 19:27:41 Jean-Francois.Lortie@acceo.com “info@intoint.com” <... Need some info and price =
1/16-11-2005 15:37:26 CN=Flemming Nielsen/O=Intoint christesen@multiban... INTOGRATE Information =
1 11-01-2014 11:18:35 hello@triggertrap.com fln@intoint.com Customer Account confirmation &)
108-04-2013 | 21:21:24 Alvaro.Te k.com info@intoint.com Nav RTC 2009 r2 and Lotus Int... =]
1 30-01-2013 09:43:02 guclu.sanli@tr.sika.com sales@intoint.com ¥nt: Intograte Download Infor... =
1|24-09-2013 |17:52:12 Thomas.Sievert@gob.de “info@intoint.com” <... Intogl = NAV & Lotus Notes 9 =
1 05-05-2012 13:13:35 Nadezhda.Davyd: com info@intoint.com INTOGRATE ]
1 04-09-2007 | 13:48:54 CN=Flemming Nielsen/O=Intoint JFL@cornator.com Re: Intration mellem Lotus No... =
1 14-02-2013 12:53:17 Haraldur@astra.is "support@intoint.co.. intograte =
1 20-12-2013 12:00:52 Johan.Caristedt @navipro.se “info@intoint.com” <... Lotus Notes integration, Dyna... E
1 14-12-2012 14:23:44 krzysztof.lapacz@floppy.pl "info@intoint.com" <... Intog pricing and licensing ]

< 1 b

Information Flow: ~ Outbound

m Home Actions CROMNUS Danmark A7S 'ZEZ'

m

The Integration Kit will automatically attempt to attach an e-mail to a contact in NAV. This attachment
takes place through a comparison of the “to” and “from” addresses with the contact addresses in
NAV. If no matching contact is found, the line will be marked in red. The contact to be attached to
the e-mail must then be selected manually in the ‘Contact No.” column.

If an e-mail is outgoing and has several recipients, it will be shown in several lines. This enables the
user to attach multiple contacts to one e-mail. The lines of a split-up e-mail will always follow each
other.

All recipients of an e-mail must be attached to a contact before the e-mail can be journalized.

Whether an e-mail is incoming or outgoing will appear from ’Information Flow’ field in the details
section.

By selecting the ‘Actions’ tab and the [Open mail in Lotus Notes] button you can view the selected e-
mail in the Lotus Notes client.

When all lines have been assigned to a contact and there are no more red lines, you can click [Post].
This will start the journaling and the e-mails will be copied to the central database so that other users
can open them through NAV. If there are no emails to be journalized, a dialog box with the text
‘There are no e-mails to journalize’ will appear.

521 Interaction log Entries

When the journaling is complete each of the selected e-mails will be attached to a contact through
an ‘Interaction Log Entry’. To view these entries, go to ‘Sales & Marketing/Order Processing/
Contacts’in the Departments’ menu, find the contact and select the ‘Navigate’tab. Click [Interaction
Log Entries]. Here the journalized mails can be found and they can be opened in Lotus Notes
through the [Show] button on the ‘Actions’tab.
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822 lgnore e-mails

There are two ways to ignore an e-mail: temporarily and permanently. Ignoring an e-mail temporarily
means to only ignore it until the next journaling. Ignoring it permanently will prevent the selected
e-mail from appearing in the journaling list ever again.

To ignore an e-mail temporarily, tick the last column called ’lgnore’. A quick way to temporarily
ignore multiple e-mails that do not have a contact attached is to click the [Functions] button and
select Ignore all without contact person’.

To ignore an e-mail permanently click the [Ignore in future] button on the ‘Actions’ pane.

A confirmation box showing information about the e-mail to be ignored in the future will appear. Be
aware that all recipients belonging to the e-mail will be ignored. The permanent Ignoring of an e-mail
will only take effect once the journaling is run (i.e. when you press [Enter] in the journaling form).

a.3 Awupointments and to-tdos

In NAV all activities (to-dos) have a field called 'Type’. If this is set to '‘Meeting’ or 'Phone Call’ it will
be synchronized with Lotus Notes!. A ‘Meeting’ corresponds to an ‘Appointment’in Lotus Notes and
a Phone Call’ corresponds to a 'To-do’.

Synchronisation takes place in two ways: Online synchronization and batch synchronization.

531 Online synchronization

Online synchronization takes place automatically when you create, modify and delete activities in
NAV of the types ‘Meeting’ or 'Phone Call’. When you update an activity, this creation, modification
or deletion is immediately transferred to Lotus Notes. Online synchronization only applies when you
update activities in NAV and not in Lotus Notes. Changes made in Lotus Notes will not be updated
in NAV until you run a batch synchronization run.

532 Batch synchronization

Batch synchronization transfers several changes at a time. It brings all to-dos and appointments in
Lotus Notes and NAV up to date. This includes activities that have previously been synchronized. It
may take a while since the system will go through all appointments and to-dos.

A batch synchronization run can be started in the following ways:

¢ Go to Departments/Sales & Marketing/Sales/Lotus Notes Integration and activate
synchronization by clicking the menu item "Synchronize with Lotus Notes’.

e When NAV is started a dialog box enabling the user to start a synchronization run will
appear, if this options has been enabled.

5.3.3 Synchronise changes

If the system has been configured to run synchronization, the following changes will be synchronized
(provided that the sales person is set to the active user):

e When you create a new activity and set the ‘Type’field to 'Meeting’ or 'Phone Call’, the
new activity will be copied to Lotus Notes as soon as it is saved.

e When you modify an existing activity that has the 'Type’field set to ‘Meeting’ or ‘Phone
Call’, the modification will be copied to Lotus Notes as soon as it is saved unless the
corresponding to-do or appointment in Lotus Notes has been marked private.

e When you cancel an existing activity which has already been synchronized with Lotus
Notes from NAV it will immediately be deleted from Lotus Notes unless the
corresponding to-do or appointment in Lotus Notes has been marked private.

¢ When you modify a to-do or appointment in Lotus Notes which is not marked private and
which has already been synchronized with NAV the changes will be copied to NAV the
next time you run the synchronization from NAV.

e When you delete a to-do or appointment which has already been synchronized from
Lotus Notes and then do a synchronization run from NAV the corresponding activity in
NAV will be cancelled.

1 Provided that the user has activated synchronization in the CRM settings.
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e If you change the 'Salesperson code’to someone other than the active user, the activity
will be deleted from Lotus Notes.

5.34 Deleting appointments and to-dos

If a to-do in Lotus Notes which has a corresponding activity in NAV is deleted from Lotus Notes, the
activity will be updated in NAV so that the next time the synchronization is run, it will be set to
cancelled.

If an activity is deleted in NAV, the corresponding activity will be deleted in Lotus Notes provided that
the activity has not been marked private.

5.3.9 Limitations on appointments and to-tos
e Recurring meetings are not fully supported
e Team meetings are not fully supported.

e If changes are made in NAV and Lotus Notes, within the same minute, changes will not
be synchronized.

a4 Contact synchronization

In addition to mail and calendar integration, the Integration Kit enables synchronization of contacts
between Lotus Notes and NAV. The address book synchronized will be the one specified in the
user's CRM settings (see section 3.1 Setting up users).

Synchronisation can, | enabled, take place automatically when NAV is started and when a user
modifies a contact attached to him or her. The user can also start the synchronization manually.

If the system is configured to run contact synchronization, the following changes will be
synchronized:

e When you create a new contact and the ‘Salesperson Code’is set to the active user, the
new contact will be copied to Lotus Notes as soon as it is saved.

e If the 'Salesperson Code’ is changed to a different sales person in an already
synchronized contact, the contact will be deleted from Lotus Notes. If the contact is of
the type Contact Company, attached contact persons will also be deleted in Lotus Notes
since a change of the *Salesperson Code’ will automatically be copied to all attached
contact persons in NAV.

e If the contact person information is changed in Lotus Notes, these changes will be
updated in NAV on the next synchronization.

e If changes are made in NAV and Lotus Notes, within the same minute, changes will not
be synchronized.
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AnpendixA  Adjustments to NAY

The below table describes all the elements in NAV which are adjusted or added by the Integration
Kit (adjustments are described in relation to the standard CRM module).

All modifications in code added to existing design-elements are surrounded by the following:
/I INTOGRATE START

.... code modifications

/I INTOGRATE END

Modifications to local and global variables are not described in the code, but can be seen in the text
versions of the import files. These can be found on the INTOGRATE CD or in the installation
directory.

New elements

Object type | Object Id
Table 121 Synchronization Entry 79540
Table 121 PIM User Setup 79541
Table 121 E-Mail Journaling Header 79542
Table 121 E-Mail Journaling Line 79543
Table 121 PIM Setup 79544
Page 121 PIM User Setup 79540
Page 121 PIM User Setup Card 79541
Page 121 E-Mail Journaling 79542
Page 121 PIM Setup 79543
Page 121 E-Mail Logging Filter 79544
Report Synchronize with Lotus Notes 79540
Code unit Lotus Notes Mail 79540
Code unit Lotus Notes Management 79541
Code unit Lotus Notes E-Mail Journaling 79542
Code unit Lotus Notes Handler 79543
Code unit Lotus Notes Version Specific 79544
Code unit Lotus Notes Mass Mailer 79545
MenuSuites | INTOGRATE_RAW 80

Adjustments to existing elements

Object Object Id Modifications/comments

type

Table Contact 5050 | New field: “Version No.” (79540)
Onlnsert()
OnDelete()
OnRename()
OnModify(xRec)

Table Attachment 5062 | New type added to 'Storage Type’.
OpenAttachment(Caption, IsTemporary)
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ShowAttachment(SegLine, WordCaption,
IsTemporary)

Table To-Do 5080 | New field: “Version No.” (79540)
Onlnsert()
OnModify()
OnRename()
CreateRecurringTodo()
Page Create To-do 5097 | ShowStep(Visible: Boolean)
Codeunit | LoginManagement 40 LoginStart()
Codeunit | ApplicationManagement 1 LogInStart()
LogInEnd()
Codeunit | Mail 397 Most methods are modified by the Integration

Kit.
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